<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your Computer</td>
<td>7</td>
</tr>
<tr>
<td>American Graffiti</td>
<td>8</td>
</tr>
<tr>
<td>Canberra Comment</td>
<td>12</td>
</tr>
<tr>
<td>Industry Updates</td>
<td>14</td>
</tr>
<tr>
<td>Tech Tips</td>
<td>22</td>
</tr>
<tr>
<td>Personal Computer of the Year Awards</td>
<td>34</td>
</tr>
<tr>
<td>The Finalists – This most diverse selection</td>
<td>42</td>
</tr>
<tr>
<td>Computer Observations</td>
<td>46</td>
</tr>
<tr>
<td>Telearadiology</td>
<td>48</td>
</tr>
<tr>
<td>Sonic Blaster for the Apple IIGS</td>
<td>52</td>
</tr>
<tr>
<td>OS/2 Alternatives</td>
<td>58</td>
</tr>
<tr>
<td>WordPerfect 5.1</td>
<td>64</td>
</tr>
<tr>
<td>The Forth Column</td>
<td>67</td>
</tr>
<tr>
<td>Archivist Database for Source Material</td>
<td>68</td>
</tr>
<tr>
<td>New Connections</td>
<td>70</td>
</tr>
<tr>
<td>Laptop clinic: Doing without disks!</td>
<td>78</td>
</tr>
<tr>
<td>Builder</td>
<td>86</td>
</tr>
<tr>
<td>Power to the PC!</td>
<td>88</td>
</tr>
<tr>
<td>Computer Based Training with Author</td>
<td>94</td>
</tr>
<tr>
<td>Presenting PowerPoint</td>
<td>96</td>
</tr>
<tr>
<td>Amazon Chess</td>
<td>102</td>
</tr>
<tr>
<td>Windows 3.0 gains a convert</td>
<td>104</td>
</tr>
<tr>
<td>Don't Prosecute: Educate!</td>
<td>110</td>
</tr>
<tr>
<td>Release Updates</td>
<td>112</td>
</tr>
<tr>
<td>Numerology</td>
<td>125</td>
</tr>
<tr>
<td>Your Amiga</td>
<td>128</td>
</tr>
<tr>
<td>Windows Wonderland</td>
<td>130</td>
</tr>
<tr>
<td>Assambling QuickBasic – Part 13</td>
<td>134</td>
</tr>
<tr>
<td>CD-ROM</td>
<td>141</td>
</tr>
<tr>
<td>Your IBM</td>
<td>144</td>
</tr>
<tr>
<td>Your Apple IIGS</td>
<td>146</td>
</tr>
<tr>
<td>Vern. V. Shrunkle, M. D. (Honorary)</td>
<td>151</td>
</tr>
<tr>
<td>Write Bytes</td>
<td>153</td>
</tr>
</tbody>
</table>

Your Computer

The Windows are open. ‘To the majority of users, the significance of an interface such as Windows is that the commands are common across a number of applications.’

American Graffiti

On desktop publishing: ‘The cultures involved are practically polar opposites.’

Canberra Comment

Science and technology conference: ‘When you don’t know, even roughly, what is happening with something you use everyday, it leads to a level of alienation from the practical world.’

Industry Updates

European Cyberspace Congress; Information Technology policies slammed; DVI developments; Personal privacy ignored; Doctor Disk now McAfee agent; HyperCard 2.0 update... and more.

Tech Tips

Share and Dos 4.0; Dos 4 installation; Microbee to Mac; Volume labels; Parity errors; Dos 5.0; Windows icons, Internal or external modem? VGA on old monitor? Hint: OEMM crashes.

Personal Computer of the Year Awards

The Finalists – This most diverse selection we’ve seen ranges from a notebook to a workstation!

Computer Observations

Peter Spencer takes the mystery out of things computer-ish.

Telearadiology

Neurosurgeon Brian Bennett has developed a technique that will alter the way doctors communicate.

Sonic Blaster for the Apple IIGS

The sound capabilities of the GS are now well established, but products taking advantage of this have been a long time coming.

OS/2 Alternatives

Looking for a multitasking operating system for your '86, but don’t think OS/2 is the way to go?

WordPerfect 5.1

Version 5.1 adds new power and low end desktop publishing.

The Forth Column

Temperature conversion - the solution.

Archivist Database for Source Material

For researchers working with printed material, here’s a useful database manager with a word processor and powerful customising features.

New Connections

Token Ring for Mac, AS/400 connectivity for Novell; OTC Easiflex; PS/2 internal modem; Motorola strategy; Telecom’s SPINE; International Telecommunications Users’ Group...
SONIC BLASTER
THE APPLE IIIGS

The sound capabilities of the GS are now well established, but products taking advantage of this have been a long time coming. Richard Walding takes note of the Sonic Blaster...

UNTIL NOW, THE only digitisers of note for the GS were SuperSonic and FutureSound — and both have been given extensive promotion in Apple’s IIIGS and Music booklet. Their major limitation was that even though they could play back in stereo, they could only sample in mono. To create stereo you had to sample twice in mono, and if you could align the tracks well enough, you would have simulated stereo. Applied Engineering’s Sonic Blaster can playback and sample in stereo. It comes with some added features such as an oscilloscope.

The ads describe it as a ‘full-featured stereo digitiser which records, amplifies and plays back in rich, full stereo’. It is also an ‘awesome sound effects amplifier that’ll knock your socks off playing great new IIIGS games like Tomahawk.’ I can’t disagree with any of that: the sound from Akaioid II through an amp and big speakers is stunning. However, I bought Sonic Blaster for serious business — for my senior physics class.

Hardware installation
THE CARD FITS into slot two or if you want to, slots one or six. The mounting plate has two 1/4 inch stereo jacks — input and output, and is mounted into the back panel. The ribbon cable on the card is plugged into the 7-pin Molex audio connector on the GS motherboard. The volume pots on the card then need to be set depending on whether you’re using the GS speaker or external speakers. If you have a modem in slot two, you can toggle between the two from the Control Panel depending what you want active. Then, installation is complete, but keep in mind that it is like two cards in one — stereo digitiser and stereo playback.

The software comes on two 3 1/2 inch disks. One contains the program including sufficient GS/OS system files to run it, and the other is the Audio Art disk which has some of the most woeful digitised samples imaginable. They’re from AE’s extensive library, and if that’s the best they can do, someone should be sacked!

The program runs in the ProDos environment, using super hi-resolution graphics, and the Mac-like interface makes the program’s user intuitive. To playback a sound you merely click and drag down the File menu and open the selected file. A Sound Graph appears at the bottom of the screen. The Select Bar is a flashing line within the Sound Graph which enables you to choose the part of the file you want to play, and then just select Play. Play may be continuous or repetitive, and while playing, the volume and playback rate may be altered by using the ‘thumb’ slides. The default rate is 22,085Hz. Resolution tells you the ratio of how many sound samples per screen pixel are being displayed in the graph. A resolution of 1:1 means that every pixel represents one sound sample. By using the Zoom In or Zoom Out option in the View menu, this may be changed.

The Edit menu, which is easy to use, allows you to cut, paste and copy selected parts of the sound graph. The Effects menu enables you to amplify selected parts or to play them backwards, create a variety of echoes, to fade up or down, or to even create silence.

The recording ability of the card is most interesting. The Auto Gain feature enables you to have input signals from a pair of microphones (low-level), a line out from a stereo amplifier (medium), a stereo headphone jack or external speaker jack from a radio (high-level).

The Record Level can also be set using the VU meter bars on the screen or by choosing Oscilloscope from the View menu. The oscilloscope gives real-time feedback of the input and can show either Channel 1 or 2, but not both together.

Listening tests
PLAYBACK OF synthesised sounds is very impressive, however, recording is another matter. The analog-to-digital converter in the Ensoniq 5503 chip takes about 31 microseconds to read each sample. hence a maximum sampling rate of about 32KHz. But even though it can sample at 30968Hz in mono or 15184Hz per channel in stereo, it is certainly not hi-fi. No matter what you may have read. The ads claim a ‘sound quality near that of a compact disk’ but this is stretching the truth somewhat.

Audio engineers have a rule of thumb called the Sampling Theorem, which was formulated by Shannon in 1949 when he built on earlier work by Nyquist in 1924. Signals must be sampled at a rate at least twice the highest frequency (fmax) of the input signal otherwise high frequencies will masquerade as lower frequency signals (known as ‘aliasing’). The rule of thumb is to use a sampling rate of 2.5 fmax. In digitally recorded music, such as that found on CDs, the audio frequency range of 20-20000Hz must be faithfully sampled. A Nyquist frequency of 40-50KHz is required. CDs are sampled at 44.1KHz per channel, that is a rate of 88.2KHz for the two interleaved channels, Digital Audio Tape (DAT) is sampled at 48KHz per channel, while the Sonic Blaster samples at 15.184KHz per channel. In mono, the sampling rate of 30.368KHz is more respectable but certainly below that of the Mac.
Most sound consists of some fundamental frequency along with some multiples (harmonics). A pure tone from an audio generator has no harmonics apart from the fundamental. It is mainly the harmonics which make a piano sound different to a violin. Most sound is much more complex with many harmonics and noise, compounded by attack, sustain and decay curves as well as the resonance characteristics of the instrument itself. Not only does the amplitude (loudness) change during these three stages of a sound, but also the relative intensity of the harmonics. In *Sonics* magazine (February 1990, p66), Michael Spicer discussed the complexity of clarinet waveforms. Because they contain mainly odd harmonics in

Sonic Blaster can playback and sample in stereo – it is a ‘full-featured stereo digitiser which records, amplifies and plays back in rich, full stereo’ and includes a very useful oscilloscope. The card fits into slot 2 of the GS’ motherboard, but could also be fitted to slots 1 or 6.

The oscilloscope with Sonic Blaster enables you to alter the gain manually or use the auto gain option and view the left or right channel. Also, a waveform can be frozen and that’s something that can’t be done with most CROs under $1000.
SONIC BLASTER

This is a sample of a few seconds of a violin solo, zoomed in to display just a few waves. Comparing the waveform to that of a standard violin waveform on the ConcertWare plus Midi program on the Mac, showed how impressive the system is.

their lower register but even harmonics in their higher octaves, they are difficult to synthesise, and when done, are usually done badly. As the frequency of the sound increases, he modulates the even harmonics exponentially while decreasing the odd harmonics exponentially. When this is done properly, a smooth transition and noticeable crossover results. It just goes to show that waveform analysis with the Sonic Blaster program is very basic, but also very useful. It would be nice to be able to do Fourier analysis and break down the complex sampled waveform into its component sine waves.

The oscilloscope is great and you can alter the gain manually or use the auto gain option and view the left and right channels. But, best of all, you can freeze a waveform - something you can't do with most cathode ray oscilloscopes under $1000. You need a storage CRO to capture a waveform and review it later, however, the Sonic Blaster can only freeze a moment in time. But it too is limited. I fed a sine wave into the card and it went well up to about 2000Hz. After that, the sampling rate limitations showed up and the waveform became incoherent. Jim Rowe, editor of Electronics Australia, argued that the Nyquist frequency for a CRO should be 10 times the maximum frequency to be sampled so you can distinguish between sine, triangular and square waves for a start (December 1989, p86). An audio sampler requires a CRO with a bandwidth of 200KHz, and even the cheapest CRO is about 6MHz.

I'm still impressed though, and it is very useful, particularly if you don't have a CRO. The first handful of harmonics in a one-metre long PVC drain pipe are still within range and can be assessed easily. You can even look for nodal points in a pipe, as long as the auto gain is off.

To digress for a moment, Peter Phillips (YC, January 1990, p157) mentioned an Australian made stereo card he saw at the Apple Developer's Conference. The Sounds Alive card is produced by Power Up Technology – it's priced at $89 (including tax) and the company can be contacted on (07) 899 1180. I spoke to Joe Eltloff, one of the card's designers and saw the card in action. Originally, it was only going to be a stereo card, but there was some space on it so he added an op amp and a few resistors and made it a digitiser as well. While the stereo playback part of the card is similar to the Sonic Blaster, it can only sample in mono just like the SuperSonic card. The maximum sampling rate is 31.5KHz and the quality is close to the Sonic Blaster, perhaps marginally less. It is packaged as a card plus manual but no specific software. Eltloff supplies very good public domain program called Sound Studio and a few hundred digitiser samples for six dollars. However, it does not have an oscilloscope.

At the Developer's Conference, he was told by Apple representatives that he was wasting his time making a stereo card as Apple were about to release a stereo GS soon. The GS is not a stereo machine – it needs a stereo card. Eltloff went ahead anyway and we're all still waiting for Apple's pronouncement to come true.

If you want to make your own card or read more about programming the sound chip, the book Inside the Apple IIGS by GS developer Gary Bond is hard to beat (Sybex $49.95). It has diagrams for both the stereo and digitiser circuits, hints for writing wave tables and a description of the sound tools.

Product Details

Product: Sonic Blaster
Distributor: Logic Group
6 West St.
North Sydney NSW 2060
Price: $300 rrp (consignment only).

The recording ability of the card is most interesting. The Auto Gain feature enables you to have input signals from a pair of microphones (low-level), a line out from a stereo amplifier (medium), a stereo headphone jack or external speaker jack from a radio (high-level).
New products with low prices

IN A WORLD where prices seem to keep rising, it's nice to report some that are falling. The PC Transporter card I reviewed in September has had a price cut of around $70 and how about a 4Mb memory card for the IIGS with 1Mb fitted for $70? Now that's cheaper than similar cards for the IBM family. Australian Two Series Software (ATSS) have advised me that they are importing a Chinook card direct from the US which is DMA compatible, meaning it works with the new Apple SCSI card. With some software bombing out even on a 1.25Mb GS, adding extra Ram is now almost essential. The card fits in the memory expansion slot, so if you have a 1Mb card (like me, purchased originally for around $800), sell it to a 'friend' and upgrade.

On the subject of new products, the line-up of Seven Hills Software for the IIGS is now being distributed by ATSS, and they have supplied me with several programs to look at. The first has to be the most essential program I can think of: an NDA called Disk Access, which costs $59.95 and is worth its weight in Ram chips. Another from the range is GraphicWriter III, a desktop publisher that links back to the original GraphicWriter program. The main features of Seven Hills Software products are their relatively low price and lack of copy protection, which conforms to the Apple decision not to support any company that uses copy protection.

Disk Access

DISK ACCESS is a disk management NDA that, when installed, occupies 128K of Ram space. The program also includes a launcher, called Out to Launch which can be used if the IIGS Finder is taking too much room on a disk. At initial boot up of the single 8.5-inch disk, the Out to Launch program is the first thing you see, set ready to invoke Apple's Installer. This then allows the NDA to be installed on a hard drive or a program disk. Like all NDAs, it only works with IIGS specific software and is accessed via the Apple menu.

The facilities provided include disk formatting and a most useful option called Show File which lets you see the contents of a text file. Appleworks GS files are displayed, complete with all formatting commands, and the file can be printed or saved somewhere else. As well, there are commands to copy, rename, delete, move, verify and find files. This latter command will search for a text string in all files within the current prefix, making it easy to locate a file whose name you have long since forgotten.

Item Info displays a selected file's size, type, date created and modified, and options such as Allow Read can be set or reset. By selecting Preferences, files can be shown in hexadecimal (good for programmers) and sorted according to numerous options. In fact there are so many options that I can't think of anything this great NDA can't do, at least when it comes to disk management. Its only draw back is that it requires 128K of memory, making the Ram card mentioned before an attractive option.

GraphicWriter III

THIS PROGRAM has a long history and started life as GraphicWriter, originally

Disk Access is an NDA that does everything the IIGS Finder can do and more. Show File will display the text of an ASCII file (such as Appleworks GS), and even lets you print the contents of the file. And now you can format a disk from within any IIGS specific program.

GraphicWriter III allows graphics to be imported from Printshop and from most IIGS paint programs. Graphics and text are all placed in frames which can be sized and positioned to suit. Graphics can also be created with the drawing tools, or you can use those supplied on the two Clip Art disks.
Katie's Farm has all the usual animals which can be sat on, fed or just looked at. The chook-house is on the right, where fluffy little chickens free range just waiting to be picked up. It's cute, has great sounds and beats TV any day.

McGee can wake up Mum, say hello to the cat, play the music box or go back to many more possibilities. The digitised sounds along with the action graphics make it all very real and entertaining for kids and adults.
Easy to play, hard to master... that's Qix. Contain the Qix before it, the spax or the fuse infect you with the Qix virus (metaphorically speaking).

Milliken Story Teller is for children learning to read. Three stories including the Ugly Duckling are supplied in the package, and a 'real' voice reads the text, which can also be underlined in sequence with the speech.

written by Data Pak. Seven Hills Software then combined forces with Data Pak and produced Graphic Writer II, followed now by GraphicWriter III in which Data Pak seems to have been forgotten.

The first thing you notice about this program is that it is different to Appleworks GS and Medley, different enough to require continual access to the manual until you get to know the program. Desktop publishers (DTPs) all have their methods of achieving the outcome of a finished document, and like most DTPs, GraphicWriter III relies heavily on frames. The other characteristic most people look for in a DTP is speed and, in this regard, GraphicWriter III beats its IIGS competitors, although speed is not blinding. The scroll bars are fairly fast, and screen up date for each change of view is tolerable.

Like any DTP, GW III combines a word processor and a graphics program with the facility to integrate the two. It supports text import from most Apple word processors, including AppleWorks 3, Bank Street Writer, and others. Text import is via a translator, which ensures the original formatting comes with the document. For ASCII text, the universal translator is used, with several options that can be selected to aid the process and get rid of unwanted characters. Graphics can be imported from PaintShop or from most IIGS paint programs, again via a translator.

The word processor section is full-featured and has spell checking, find and replace features along with the usual formatting commands. To help make the text more visible, the Tall Text option can be selected, unless you have chosen a point size that doesn't require further magnification. All text is entered into frames, and frames can be linked to make text flow from one frame to the next. Kerning (space between letters) is adjustable and the vertical spacing between paragraphs can be set by entering a number from 0 to virtually any value.

Space does not permit a full examination of all the features, which I can assure you are numerous. Initially I found the program a little hard to drive, but after a learning period of a few hours I decided I liked it. The manual is well laid out, and I could find answers to most of my questions. It is certainly faster than its competitors and with practice, users will soon be able to produce quality productions. A special ImageWriter driver is included to obtain a better print quality, though this driver cannot be used with other programs. The package includes two disks of clip art, another containing a range of fonts and a disk formatting NDA that can be used with any IIGS specific software. The program only chews up 768K of Ram, which also allows it to run reasonably well from a single 3.5-inch drive.

The review copy was supplied by Australian Two Series Software, (02) 606 9343, or write to PO Box 1, West Hoxton Park.
2171 NSW, and costs $159.95. Owners of Graphic Writer II can upgrade for $85, and being the distributors, ATSS provide full support for the program. Dealer enquiries about the Seven Hills Software range are also invited by ATSS.

**Losses**

WHILE NEW software for the IIGS keeps coming, there have been a few losses recently. Applied Ingenuity has now shut up shop, leaving owners of their products without support. Ingenuity produced a range of Apple II hardware peripherals, including hard drives (InnerDrive and OverDrive) and the GS Juice+ memory card. They were never a big concern in Australia, but no doubt quite a few IIGS owners have an Ingenuity product. The IIGS Buyer’s Guide has also discontinued publication. The subscriber list for the Buyer’s Guide has been purchased by InCider, and subscribers will receive it as a replacement from now on.

Apple have recently merged Claris back into the fold, after having let it run as an independent software developer for some years. Apparently Apple wanted to expand their ability to produce application software and Claris was the answer. Whether this is good or bad news remains to be seen. Apple has recently released a range of low cost Macs. The new Macs feature 8-bit or colour, which makes the IIGS still look very good. There are lots of other rumours floating in the pipe line, including a supposed big announcement from Apple about their intentions for the future of the II series computers. If this occurs, I’ll report on the announcement if it has any bearing on the IIGS. But with a string of new products coming up, I can only see the IIGS getting better and better.

**Just for kids**

TWO NEW SOFTWARE products by Lawrence Productions are now finding great favour with an audience that previously has not really been catered for. It may seem a rather dangerous exercise to let a two or three year old play with a computer, but these programs only use the mouse, and users literally cannot go wrong. In fact, the only exit is via the reset key, so running the programs from a hard disk can’t let the ankle biters accidentally wipe all your files.

The only exit is via the reset key, so running the programs from a hard disk can’t let the ankle biters accidentally wipe all your files.

At the bottom of the screen. While older children will quickly get bored, a small child will be kept amused for hours, even if they see the same graphic a hundred times. On the way they will learn orientation, hand/eye coordination, shape recognition and also gain a familiarity with a computer.

Katie’s Farm is a child’s view of a farm, with the usual animals that need patting, feeding, milking and talking to. At boot up Katie asks for disk 2 which then brings up the home graphic. From here, four more large icons let junior go to the scarecrow, the barn and the two possible entrances. The barn icon leads to a cow: some chickens, cats and a horse. It’s all very cute and kids will love the realistic sounds and actions in the graphics. Adults will be impressed by the quality of the graphics and the number of paths Katie can take.

McGee is a cute three year old who plays, chats and walks around the house with his trousers half down. He has lots of options, including waking up Mum, play-

cause the programs are not copy protected there is no problem running both from a hard disk.

The review copies were supplied by Dataflow, (02) 331 6153, the distributors for these and all Broderbund software. The price for each program is $69.95 and two disks plus a small manual make up each package.

That forgotten band of computer users, children aged around five to seven are no longer going to have to suffer television and comics as their source of amusement. Two more programs have come my way that are for slightly older children. I’ve also just discovered Qix, the latest arcade game from Taito which suits anyone from seven to seventy.

**Qix**

THE WORST THING about Qix (pronounced Kicks) is that I had to eventually stop playing it to write this review. Boy, what a compelling program, enhanced with sound that makes it a great experience. For best sound a stereo card connected to an amplifier system is essential, and the bassy, ethereal sounds generated by the program are almost mind blowing. The game is deceptively simple and requires either a joystick or the keyboard. The joystick is certainly the best way as it gives better control.

The game is rather difficult to describe. The aim is to move a pointer with the joystick to try and enclose an area that reduces the space the Qix can move in. The Qix is described by the programmers as a computer virus (it’s not really, so don’t worry) and is presented as a series of moving lines, shaped almost like an arrow. If the Qix touches the line you are drawing, blammy! Other nasties are the sparx, the fuse and the spiral death trap. You get three lives, then it’s all over. The slower (yes, the slower) the lines enclosing the Qix are drawn, the higher your score. When you have filled in more than a certain percentage of the area, the next level is reached where things get more difficult.

Eventually the Qix splits into two and the difficulty level becomes almost impossible. The game is very challenging, and I was obtaining scores of 0 to over 64,000. It’s also a game that young children can play, and I had to eventually shoo away my eight year old daughter for a go at the game. Qix is a Taito product and is available for most computer systems. However I wonder how the other systems compare with the sound produced by the IIGS. Believe me, the rock music that comes with the program makes great listening.
The recommended retail price is $44.95, and the review copy was supplied by Two Series Software (address above). But as the blurb on the packaging says, 'Qix may impair your ability to enjoy ordinary home video games.'

**Milliken Story Teller**

**STORY TELLER** is a learn to read program, and the package includes the program disk with three story disks; Little Red Riding Hood, Henny Penny and The Ugly Duckling. It works from a single 3.5-inch drive, as the program itself loads into memory leaving the drive available for the story disk. The action is simple: a graphic, some text and a digitalised voice that reads the text. The sound is very good, although the reading speed is rather fast. This is more of a problem when word underlining is selected, as the underline cannot always keep up with the voice. Pressing Ctrl-S will slow the speed by 25 per cent, but the pitch goes down accordingly giving a rather masculine sound to the female voice. Also the intonation of the voice suffers, giving a somewhat synthesised effect.

Moving to the next graphics is not as straightforward as the manual claims. Pressing 'any key' does nothing, and the trick is to move the mouse pointer to the bottom right of the screen to invoke the pointing finger icon. When this icon is present, pressing the mouse button causes the program to continue. There is a fairly long delay before the next picture appears, but children are usually more patient than software reviewers and the text appears instantly giving the user something to ponder during the load time. The graphics are relatively simple and the program is an excellent way to have kids improve their reading skills.

Comprehension can also be tested by selecting Questions from the Preferences menu. When this option is set, a question such as 'where is the ...?' is posed every four or five screens. Moving the pointer and clicking on the correct object is rewarded with a graphic that replaces the text section of the screen. Get it wrong and the question is asked (verbally) up to three times after which the required object is framed.

Although not referred to in the manual, there are two hidden mouse commands that are accessible anytime during a story and that might be accidentally triggered by an adventuresome child. The top left of the screen hides the Exit command, and the top right gives access to the Preferences. This allows the options (Speech, Underline and Question) to be changed during the course of the story. Pressing P also invokes the Preference menu.

A nice touch is the colouring-in section included at the end of each story. The outline of one of the graphics used in the story is shown, where the user first selects from a pallet of 15 colours at the bottom of the screen then points to an object in the picture which then fills with the selected colour. It's fairly slow, but children will love it.

The review copy was supplied by Dataflow. The recommended price was not available at the time of writing.

**The Ugly Duckling**

IT'S PERHAPS unfortunate that Byte Works decided to use The Ugly Duckling as the story in their program for early readers, as Milliken opted for this story as well. However it is interesting to compare the two programs, as they both behave differently albeit to achieve the same thing. The graphics in the Byte Works version are more detailed and the text is integrated with the picture. The text is automatically highlighted as it is read and, unlike the Milliken version, this program is childproof.

A five year old knows nothing about a mouse and an icon, but is happy to bash a fist onto the keyboard. Except for the Escape key, which returns the program to its opening menu, banning 'Any Key' simply makes the program go to the next frame. Here the previous frame dissolves gently into the next, so the delay seems less apparent. In fact, the time between frames is quite short anyway, as it is based on System 5.1, rather than System 4.0 as in the Milliken version.

The options don't include testing comprehension, but the user can select 'wait and read' or 'read and wait'. The first option highlights each word in red, then waits for junior to press any key after which the word is read aloud. The second highlights the word as it is being read, again only after a key is pressed. During the course of the story, the option of returning to the previous page is available, achieved by clicking the mouse on the left arrow icon. Other icons include the Go icon which is used during the 'wait and...' options, a Stop icon to pause the reading process and a right arrow to go to the next frame. Thus an adult can supervise and control the story if required.

The digitised voice sounds excellent, and the reading speed is slower than the Milliken version. Because the graphics are more complex, the whole story requires two disks. When the first is finished, it automatically ejects, and a graphic makes it clear what must be done at this point. That is, put in the pink disk. If the blue disk is required, the graphic tells you. Kids are able to put a disk into a drive, but find it hard to get the disk out, hence the automatic eject feature.

But the feature that will appeal to teachers is the price. The recommended price of the program is $59.95, but this allows the purchaser to copy it for all computers in the classroom. If a school is lucky enough to have 30 IGS computers in a classroom, the teacher can legally make 30 copies. The only restriction is that a copy needs to be purchased for each room. The program is not copy protected and therefore runs from a hard drive. While it will operate on a network, this is not recommended due to the reduced speed of operation.

The story can also be printed out, and special colouring in pictures can be printed. The idea is to give the kids a hard copy of the pictures so they can read or colour in after watching the computer version. Hitting the reset key is the only way to exit the program, as with the Milliken version.

Comparing the two programs gives good and bad for both. The Milliken version includes three stories, but the program is more difficult to operate and is not childproof. The Byte Works version needs at least one disk change, although Story Teller requires that the program be loaded first before the story disk is inserted. The reading pace is much better in the Byte Works version, and the printout option will be useful to many parents and teachers. The choice is yours.

The review copy was supplied by Two Series Software (address above) and has a recommended price of $59.95 which covers a room license as well.